Realize Your Product Promise®

Workshop 03:
Advanced Power Integrity Simulation




Overview

* This Workshop shows the process of setting up a Pl Advisor simulation for a PCB design to validate and
optimize the decoupling strategy using ANSYS Slwave

Configure impedance

analysis Define Target Impedance PI-Advisor Simulation
i : (Optional)
e s Component Mapping of?ve‘z/ic;r;antrrzgde anq!ys:s p I «Optimize capacitor strategy to meet
eCapacitors and Inductors ) @G e el eConvert VRM and load spec. to impedance mask
e Without decoupling capacitors target impedance mask

ePlot impedance response and SSN
e/mpedance plot
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Realize Your Product Promise®

Import Design




Slwave for Impedance Analysis

* Starting Slwave
—To launch Slwave, click the Microsoft Start Button, select: All Programs = ANSYS Electromagnetics

- ANSYS Electromagnetics Suite 18.0 2 ANSYS Slwave 2017

* Load design File
— Click the Open Project box

> Navigate to the training files and choose: PI_Advisor_example.siw
> Press Open

E»] Welcome to ANSYS Slwave 2017.0

S . ¢ R
g =h
D New Project 4 Import ANF...

| E Import Cadence Allegro/APD/SiP...

V ?7 Open Project

Mentor PADS 9.4 and higher
Mentor Expedition EE7.9.2 and higher

I T

Import DXF...
Import GDSIL..

9 Import ODB++ Design...




Slwave Workflow Wizard Dialog

* Opening the Workflow Wizard

o
— In the Common Functions menu, click Dialog button E-l E“% ] = '-IF-"

£ Slwave Workflow Wizard
ia Import Component File...

j‘g Import Stackup...

o/ Q Verify Stackup...

o/ ;; Verify Padstacks...
RS 3 5 3
L% =E= Verify Circuit Element Parameters...

) 4 Sanitize Layout for Simulation

Assign S-parameter Capacitor Models...

Assign SPICE Netlists...

Configure DC IR Drop Analysis...

Configure PI Analysis...

v Always show this dialog after project import:

&/ == Verify Power/Ground Net Classification..

J\

| (Optional) Import Settings
from Previous Simulation

| Verify / Modify Geometry,
Materials, and Circuit Elements

—

—

J\

} (Optional) Pre-process Overlapping Geometry

— (Optional) Assign Broadband Models

— Setup Simulation
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Verify Stackup

* Modify Stackup and Material Properties

— Click on the
e This is the stackup from the original import. We would like to use a stackup generated from a previous design.

— Click Cancel to close this window.

N = 5|
Color | Name Type % Thickness mis) &y Matenal Conductivity (S/m) |43 Dielectric Fill Dislectric constant | Loss tangent | Translucency | Blevation fmis) | Roughness frils)
:_@ Import Component File... SM DIELECTRIC 0.65 SM 0 34 0.016 1885
» Wl SURFACE METAL 12 capper 5.8E+07 sM 34 0018 & 17.05 HJ0,HEO
UNNAMED_3 DIELECTRIC 41 PP_CORE 0 42 0.02 1295
[ METAL 1z capper 5.8E-07 PP_CORE 42 0.02 &0 1.75 HJ:0,H O
i‘a Import Stackup... CORE DIELECTRIC 4 PP_CORE 0 42 0.02 77
| E METAL 1z copper 5.8E+07 PP_CORE 42 0.02 60 655 HJ0 HLO
UNNAMED_7 DIELECTRIC 41 PP_CORE 0 42 0.02 245
S ] O easE METAL 18 copper 5.8E+07 M 34 0.016 60 065 HJ0 HLO
L % & Verify Stackup.. sM_B DIELECTRIC 065 sm 0 14 0016 0
ot Verify Padstacks...
< =E= Verify Circuit Element Parameters...
Add [ Delete / Move Layer(s) Edit Selected Layer(s)
™ ’ ... Add Above Selected Layer _
{1 =k~ Verify Power/Ground Net Classification... B Calor I 002000 Update Dielectric il [5M - Update
= Add Below Selected Layer
_——————— SURFACE Update Translucen — '— 60% Update
Delete Selected Layers Neme L‘ < L‘
1 » - . . ks METAL = Update Thidness [ 18 I Update
L) . Sanitize Layout for Simulation Rbe e e = me_tesee |
. Move Selected Layers Down Material |copper - Update Roughness HI: 0, H3: 0 | e Update |
Assign S-parameter Capacitor Models... Selectall [DIELECTRIC 7] layers | Apply | EdtMaterial Properties | Invertstadup | [ conformalcoat  Units [mis - Cancel

A

Assign SPICE Netlists...

Configure DCIR Drop Analysis...

Configure PI Analysis...
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Import Stackup

* Importing a Stackup from a Previous Design
— Click the Import Stackup button.

— Locate in the same directory as the Slwave file
— Click Open to apply the stackup.

@ Slwave Workflow Wizard Select Ansoft Component File to import x|
(_:‘J (_) ‘ = Computer = Local Disk (C:) ~ training - [@J I Search training \!:_e]‘l
ia Import Component File... Trm e [T RS = - 1@

Yt Favorites Name ~ | Date modified | Type | Size | |
2 B Desktop KUP. stk 0 610:41AM  STKFile
<

j Import Stackup... % Downloads

2] Recent Places
& Onelrive

Q Verify Stackup...

4 Libraries
3 Documents

. & Music
Verify Padstacks... &) Pictures

E Videos

Verify Circuit Element Parameters... 1% Computer

£2, Local Disk (C3)
(s STORAGE (D2)
Verify Power/Ground Net Classification...

.||."I

€ Network

© o000
L

"4 Sanitize Layout for Simulation File name: [WS3_STACKUP.stk x| [stwave Layer Stackup Files (st x|

Open |v| Cancel |

A

Assign S-parameter Capacitor Models...

Assign SPICE Netlists...

Configure DCIR Drop Analysis...

Configure PI Analysis...

v Always show this dialog after project import
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Verify Stackup

 Verify Imported Stackup

— Click on the Verify Stackup button once again.

¢ Importing the stackup from the last step has modified the material for metal layers. Importing the stackup
can modify any and all parameters in this window.

¢ Verify that the outer dielectric layers are now of type conformal coat.
— Click Cancel to close this window.

9 S Wk Wi 5,

Color | Name Type % Thickness (nis) &y Materal Conductiviy (S/m) | &y Dislectric Fi Dielectic constant | Loss tangent | Transiucency | Blevation (nils) | Roughness (mik)
i{] Import Component File... sm CONFORMALCOAT 065 s 0 34 0016 1885
» Bl SURFACE METAL 8 copper 5EETT M 34 0016 o0 1705 A0, A0
UNNAMED_3 DIELECTRIC 41 PP_CORE 0 12 002 1295
5 W v METAL 12 copper 5BE-07 PP_CORE 42 002 &0 175 HJ:0, HJ:0
:'{] Import Stackup- CORE DIELECTRIC 4 PP_CORE 0 42 002 775
H G METAL 12 copper 5.8E+07 PP_CORE 42 002 & 655 HU: 0, HU: 0
UNNAMED_7 DIELECTRIC 41 PF_CORE 0 42 002 245
& Verify Stackup... I ease METAL 8 copper 5.8E+07 sh 24 0016 & 065 HJ: 0, HY 0
S_B CONFORMALCOAT 065 s 0 34 0016 0

e

. Verify Padstacks..

=®= Verify Circuit Element Parameters...

Add [ Delete / Move Layer(s) Edit Selected Layer(s)

Add Above Selected Layer
e A 1| color I 003000 Update DiekectricFil  [sM <] Update
Add Below Selected Layer
- —_— Name | SURFACE Update Translucency j— 60% Update
s Sanitize Layout for Simulation Delete Selected Layers
Move Selected Layers Up Type  |METAL = &I Thidness  [1.8 mils U"d—a"el
Move Selected Layers Down Material |copper hi Update Roughness H:0,HX: 0 | mils Update I

selectall [DIELECTRIC 7] fayers apply | Edit Material Properties | InvertStackup | [ Conformel Coat  Units [mis = Cancel

Verify Power/Ground Net Classification...

ceoe
af

Assign S-parameter Capacitor Models...

Assign SPICE Netlists...

Configure DC IR Drop Analysis...

Configure PI Analysis...

/| Always show this dialog after project import

© 2015 ANSYS, Inc. January 31,2017 ANSYS Confidential




Realize Your Product Promise®

Component Configuration




Verify S-parameter Capacitor Models

* Assigning Broadband Models to Capacitor Locations
— For this exercise, we will assume that the Padstacks, Circuit Elements, and Power/Ground Net Classification has been handled properly during import.
— Click on the button.
— Verify that each local part name has an associated S-parameter model.

e The file in the workshop files directory maps each local part to a suitable part from Slwave’s vendor library. The vendor library includes
directly from . The pmap file was exported after manual setup using this dialog.

— Click Cancel to close the dialog.

5 S oo i 5.
Local Part Mame Type Value Size Est Manufacturer | Series Part Name Matched Value = Matched Size
ﬂ Import Component File... 602431005 Capactor |470.000000pF 0603 Murata GRM18 GRM188R71H47... 470.000000pF 0603
602433026 Capactor | 2200000uF 0603 Murata GRM18 GRM18BR71AZZ.. 2200000uF 0603
602433038 Capactor | 4.700000uF 0603 Murata GRM12 GRM18BRE1A47.. 4700000UF 0603
= 602433057 Capactor | 47.000000nF 0603 Murata GRM1S GRM188R71C47. 47.000000nF 0603
j Import Stackup... =
602433075 Capactor | 10.000000uF 0603 Murata GRM18 GRM18BR61A10.. 10.000000uF 0603
602433081 Capactor | 22000000uF 0603 Murata GRM18 GRM18BRE0G22.. 22000000uF 0603
— 644066020 Capactor | 100.000000uF 1410 Murata GRM32 GRM32ERG1A0... 100.000000uF 1210
) &2 Verify Stackup... 644066-115 Capactor | 47000000uF 1206 Murata GRM31 GRM31CRG1A47_. 47.000000uF 1206
A32422019 Inductor | 2200000uH 2816 TDK VLF10Bo  VLFI0040T-2R2.. 2200000uH  Cther
A36094-025 Capactor | 10.000000pF 0402 Murata GRM15 GRM1552C1E10... 10.000000pF 0402
W Verify Padstacks.. A36095-042 Capactor | 18.000000pF 0402 Murata GRM15 GRM1552C1E1S. . 18.000000pF 0402
AI6095-045 Capactor | 220.000000pF 0402 Murata GRM15 GRM1552C1E22.. 220.000000pF 0402
A36096-027 Capactor | 1000000uF 0402 Murata GRM15 GRM155RETATD.. 1000000uF 0402
PP Ta— A36096-030 Capactor | 100.000000nF 0402 Murata GRM15 GRM155R71AT0.. 100.000000nF 0402
W | 2% Verify Circuit Element Parameters.. 36095045 Capactor  1000000nF 0402 Mumta GRM15 GRM1SE2CIE1D.. 1000000nF 0402
AI6096-066 Capactor |4.700000nF 0402 Murata GRM15 GRM1S5R7IE47.. 4700000nF 0402
A36096-108 Capactor | 10.000000uF 0402 Murata GRM15 GRM155RE0ET0.. 10.000000uF 0402
) S Verify Power/Ground Net Classification... A4TAD2-001 Capactor | 1.000000pF 0402 Murata GRM15 GRM1554CIHIR... 1.000000pF 0402
= 33410012 Capactor | 1000000uF 0201 Murata GRMO3 GRMO33R6U10.. 1000000uF 0201
96005001 Capactor | 100.000000nF 0402 Murata GRM15 GRM155R71A10.. 100.000000nF 0402
o ‘ ) 97875001 Capactor | 22.000000uF 0305 Murata GRM21 GRM21BR61A22.. 22000000uF 0805
L - Sanitize Layout for Simulation E16347-001 Capacior | 10.000000nF 0402 Murata GRM15 GRM1S5R7ICT0.. 10.000000nF 0402
E53905-001 Inductor | 80.000000uH 0201 Murata BLMO3 BLMO3AXB00SN1  80.000000uH  Other
E57936-001 Capactor | 10.000000uF 0805 Murata GRM21 GRM21BR71A10... 10.000000uF 0805
Assign S-parameter Capacitor Models... G10601-003 Capactor  10.000000uF 1206 Murata GRM31 GRM31CR71A10... 10.000000uF 1206
63888-001 Capactor | 10000000uF 1206 Murata GRM31 GRM3ICR7IA10.. 10.000000uF 1206
84983001 Capactor | 150.000000nF 0402 Murata GRM15 GRM155R71CT5.. 150.000000nF 0402

Assign SPICE Netlists...

Auta Match By Yalue | Auto Match By Hame. | Impart Part Matching File
Configure DC IR Drop Analysis... Assion S-parameter Mods] | Clear bodel Sssignment | Expait Pait Matching File

2 § Import S-parameter kiodel | Remove 5-parameter i odel
Configure PI Analysis...
v Always show this dialog after project import ﬂl

4
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Realize Your Product Promise®

Impedance Analysis

VRM Definition




Example VRM Circuit: Target 1V Supply @ 6.25 A with 50 mV Ripple

R7

R5

[| S

in+

15kOhm

68pF
E2

in- |-

+

out+

out-

L

1.2kOhm

LJ.[OB\/Y\ R109

1.5uH
1ImOhm

R~

ci10 |

R114

0.5nH

16mOhm

http://www.edn.com/design/power-management/4440087/Design-a-VRM-with-perfectly-flat-output-impedance-in-5-seconds-or-less
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VRM Output Impedance

VRM Impedance VRM #
1.00E+001
1 Curve Infa
— mag(Z(Port1,Port1))
LinearFrequency
2.96E+000

1.00E+000
E
=
=)
T
o
0. 1.00E-001 ~
b ]
o
@
N
o
m
E

1.DDE-DD2—E 800E003

100E'003 T L L L | T L L B | T L B | T LI | T L B B B I R | T T T T T T TT

1.00E-006 1.00E-005 1.00E-004 1.00E-003 1.00E-002 1.00E-001 1.00E+000
F [GHz]
1.00E-006
1.00E+000
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VRM Output Inductance

14 © 2015ANSYS, In

im(Z(Port1,Port1))/(2*pi*F)

VRM Inductance

4.00E-009

VRM

A

Curve Info

3.50E-009
3.00E-009
2.50E-009
2.00E-009 -
1.50E-009 —

1.00E-009

LinearFrequency

avg

— im(Z(Port1,Port1))/(2*pi*F) 4 7567E-010

5.00E-010 - 4 71E-010
0.00E+000 - — L NN RN I EEE . ‘
0.00 0.00 0.00 0.00 0.01 0.10
F [GHz]
0.100000
C.
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Realize Your Product Promise®

Impedance Analysis

Z11 extraction and Resonant mode analysis bare board




Pl Simulation Setup

Single active device to simplify simulation results.

Top Layer

16 © 2015ANSYS, Inc.
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Pl Ports Setup

* Click the checkbox next to the net name to select it for simulation
— The list of reference designators attached to the +1.2V net is shown on the right

* Change the Port column pull down menus for the and to Port
— Reference impedance for these ports will be set to 0.1 ohm

* Click the button to create pin groups and ports automatically
x
Ref. Des. | Part Number Positive Net Reference Met Port Ref. Imp.
CFPU1 BGA_CPU +1.2V GND Port 0.1chm
D1 SCIC_DRAM +1.2V GND Nane
D2 SCIC_DRAM 1.2V GND Nane
PCE10 CE_138_BD315_H53.. +12V GND Nane
PQ4 TO252_H34 1.2V 3.3V Nane
PRMN1 4REPS 1.2V 3.3V Nane
VRM1 VRMOD1 +1.2v GND Port 0.1chm
Fositive Met: I ﬂ pdate | Port: I j pdate |
Reference et I j lpdate | Ref. Imp:: | pdate |
Load... I Save... I | Port Maming Convention. .. I |7 Hide RLC components
U Configure Simulation U

© 2015 ANSYS, Inc. January 31,2017 ANSYS Confidential



Validate Geometry

* Click the Validate button to open the Validation Check dialog

[N PI Configuration x|

Ref. Des. | Part Mumber Positive Met Reference Met Port Ref. Imp.

C]+1.8v CPU1 BGA_CPU +1.2V GND Port 0.10hm
(C]+1.8v_BST D SCIC_DRAM +1.2V GND Naone
[]+1.8V_BSTRC D2 SCIC_DRAM +1.2V GND None
[1+1.8v_F8 PCE10 CE_138_BD315_H53... |+1.2V GND None
[1+1.8V_HG PQ4 TO252_H34 +12V +3.3V None
[1+1.8V_HGR PRN1 4RAPS +1.2V +3.3V None
[(1+1.8V_LG VRM1 VRMOO01 +1.2V GND Part 0.10hm
[(]+1.3V_0PS
[]+1.8V_PHASE
[]+1.8v_5
[(]+1.8v_vCC
]+3.3v Positive ek I J pdate | Park: I j pdate I
[(]+3.3v-1 Reference et I j m Fef, I I ﬁl
[1+3.3v-2
[1+3.3v_BST
g::?_sgmc Load... | Save... | | Port Naming Convention... I |7 Hide RLC components

LV
[]+3.3V_HGR .

+3.3V_OPS i | . . - . .

gﬂ 3.:.‘PHA5E (J - Configure Simulation |::"> 1 | validate... |:i> Simulate...
M+3.3v & ﬂ '

© 2015 ANSYS, Inc. January 31,2017 ANSYS Confidential



Validation Check

* Click the OK button to run the validation check to check for geometry errors

Launch Validation Check

r~ Check List

Select Al | Unselect All |

¥ Self-Intersecting Polygons
[V Disjoint Nets (Floating Nodes)
¥ DC-Short Errors

[V Identical/Qverlapping Vias
¥ Bondwire Collisions

] Ill=gal Eondiwire Connections
[+ Mizalignments

™| Less Than Twe Terminals

r~Select a simulation mode

ISYZ Farameters j

Minimum Area:  3100,01 mils~2

Cutouts that are smaller than
this minimum area will be ignored during
validation check.

This threshold can be changed in the
Simulation -> Global Option window.

Mets to be checked
Some nets might not be induded.
Please refer the Simulation -> Global Option
window,

o1

Number of cores to use: I 4 j

Cancel |

© 2015ANSYS, Inc.

January 31,2017

Review the list of errors (there should be none) and click OK to close the results dialog

x

 Errors
Self-Intersecting Polygons: N
Foint-Connections:
Disjoint Nets: 0 ™| auto Fix
DC-shorted Errors: 0
Identical/Overlapping Vias: 0 [T &uto Fi
Traces-Inside-Traces Errors: 0 [T Auta Fix
Collisions of Bondwires: 0
Tllegal Connections of Bondwires: i}
Identical Bondwires: 0 [ AutoFix
Reversed Bondwires: 0 [T Auba Fix
Floating Modes: 0 [T auto Fi
Zero Via Plating: 0
Mets With Less Than 2 Terminals: 0

~ Warnings
Misalignments (Planes/Traces \ias): o I Auto Fix
Bondwires Misaligned With Die Pads: 0 I &t Fix
Ping Shared By Multiple Pin Graups: 0 7| suto Fix

Cancel |

ANSYS Confidential




Pl Ports Setup Complete

* At this point you could click the Simulate button to set up and run an SYZ sweep simulation, but in this example

o Ll o o Ll o
we will do some so just click the X button to close the Pl Configuration dialog
[
I Ref. Des. | Part Number Posttive Met Reference Met Port Ref. Imp.
[J+1.8v CPUA BGA_CPU 12V GND Port 0.1ohm
[1+1.8v_BST D1 SOIC_DRAM 2V GND Nore
[1+1.8V_BSTRC D2 S0IC_DRAM 2V GND None
[1+1.8v_FB PCE10  CE_138 BD315_HE3. +12V GND Nons
[]+1.8v_HG PQ4 TO252_H34 12V =33V None
[]+1.8v_HGR PRN1 4RBPS 12V <33V None
[+1.8v_1G VRM1  VRMOD1 2V GND Port 0.1ohm
[+1.8v_OPS
[]+1.8V_PHASE
[1+1.8v_5
g:;::_vcc Positivefieti | o [N Part; | = pdate |
[1+3.3v-1 Reference ek | = | Update I Fef, I | Lpdate I
[1+3.3v-2
[1+3.3v_BST
g:::::ggmc Load... | Save... | | Paort Naming Convention. .. I W Hide RLC components
[]+3.3V_HGR
g:::::::iSE = QJ Configure Simulation |::> Q‘J' Validate... | |::> Simulate...
M+3.3v 5 hd
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* Pin groups are connected sets of pins colored green or

* Ports connected between pin groups indicate

Pl Ports

* Examine the ports and pin groups created by the PI

configuration tool

red

measurement points for S-parameters

T = T




Deactivate All Capacitors

e On the Home ribbon click the Circuit Element Parameters button

* On the Capacitors tab select all the capacitors by clicking the first row in the list, scrolling to the bottom of the
list, holding down Shift on the keyboard, and clicking the last row in the list

* Click the Deactivate button to deactivate all the capacitors

x
Capacitors | Inductors | Resistors | Ports I Violtage Probes | Cumert Sources | Voltage Sources I Met Terminals |

# | Active | &/87 | Part Number | RefDes | Capacitance (F) | Paresitic L (H) | Parasttic R {chms) | Posttive "Temin; = |
W Mo ;4 GRM188B11CT104KADT C324 1E07 5.07437E-10  0.0231146 GND

« Mo X GRM188B11C104KADT C325 1E07 5.07437E-10  0.0231146 GND

« Mo ;4 GRM31CCBOE227ME... CE4 0.00022 1.03784E09  0.00154357 GND

« Mo ;4 GRM31CCBOE227ME... CE7 0.00022 1.03784E09  0.00154357 GND

o Mo b 4 GRM31CCB0E2Z7ME... CE8 0.00022 1.03784E09  0.00194957 GND

o Mo ;4 GRM31CCB0E227ME... CE22 0.00022 1.03784E09  0.00194957 GND

W Mo ;4 GRM31CCBOE227ME... CE23 0.00022 1.03784E09  0.00194957 GND

« Mo X GRM31CCBOE227ME... CE25 0.00022 1.03784E09  0.00154357 GND

« Mo ;4 GRM31CCBOE227ME... CE46 0.00022 1.03784E09  0.00154357 GND

« Mo ;4 GRM31CCB0E227ME... CE47 0.00022 1.03784E09  0.00154357 GND -

4| | »

1389 capacitorz, 0 active, 133 inactive

Modify F‘roperties...l Modify Layers... Delete | Fit Selection Activate | I Deactivate I
Export ok | cancel |

© 2015 ANSYS, Inc. January 31,2017 ANSYS Confidential



23

Deactivate VRM Port

e Activate the Ports tab

* Click the VRM port to select it

* Click the Deactivate button to deactivate the selected port

* Click OK to save the changes and close the dialog

© 2015ANSYS, Inc.

Circuit Element Properties xl

-Capaci‘tors I Inductors I Resistors  Ports |\|’ohage Probes | Cument Sources | Voltage Sources I Met Terminals |

# | Active | Name

| Reference Impedance (Ohms) | Port Positive " Teminal" Net | Port Negative "Teminal"

4

¥ Yes +1.2V_BGA_CPU_CPU1_PIFlow 0.1

+1.2V_VRMDD1_VRM1_PlFow 0.1

+1.2V

GND

| o

2 ports, 1 active, 1inactive

Modify F‘roperties...l

Iiodify Layers...

Delete

Fit Selection |

Activate | Deactivate |

Bxport

ok | cancel |

January 31,2017
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Create Simple VRM Output Model

* We can model the VRM to be a simple series RL circuit with parameters R = 8mohm and L = 0.47nH

Click the outline of the VRM device footprint to select it

Go to Tools =» Generate Circuit Element on Components button to raise the Circuit Element Generation Dialog

L .
* The VRM1 t will be aut tically selected
e component wi € automatically seiecte
W Circuit EJ it G tion Dialog (ol x|
- Positive Terminal Component Reference Terminal Component
parttome: TR ~ | | | PortName: [|F00L K
RefDes:  [vRML =] | | Refoes: [l =l
[V Same as Positive Terminal
- Circuit Element Positive Terminal ——— [~ Circuit Element Reference Terminal - Circuit Elements
) Pin Groups Pin Groups Capaditors
I . Bl +1.2V +12V - Current Sources
! +3.30 +3.30 Inductors
GND GND Resistors
8e-3 ohm - Ports
+ Valtage Probes
- Voltage Sources
CPU_+1.2V VRM_+1.2V Termict
Port |
i
)
— CPU_GND VRM_GND 0.47nH
- N
Expand | Colapse | FindPin atLocation...
—
(¥ Use nearest pin as reference pin
€ Group pins within the reference distance
Circuit Element Type
) Caparitar (= Port
| ol | o e — | = Indlctor £ Currer b SoUrce
£ Resistor £ yolkage Source
g B ey A (R R ¢ S-Param Cir Elem € Wolkage Probe
Regemp Ol € Terminel ooe | e |

S 1 S A, - —— — —— i i
©2015ANSYS, Inc. ~ January31,2017 mﬂdemm
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Create Simple VRM Output Model

* In the Circuit Element Positive Terminal list
expand Pin Groups and select the -10/x]

~ Positive Terminal Component Reference Terminal Component
PartName:  [VRMOO1 =] | | PartName: [vmmoo: =
. . . . RefDes:  [vRm1 =l | | refoes:  [urmn =l
* In the Circuit Element Reference Terminal list % Same as Positve Terminl
expa n d Pi n G rO u ps a n d Select th e i Circuit Element Positive Terminal ——— [~ Circuit Element Reference Terminal ————— [~ Circuit Elements

E| Pi_n Groups
P +1,2V_VRMOO1_¥RM1_PIFlow
4001 WRM1 PIFlow

Current Sources
Inductors
Resistors

Ports

Voltage Probes
i \oltage Sources

® CIiCk ‘. Terminals

* In the Circuit Element Type list select

-- GND [#- GND

Expand | Collapse | Find Pin at Location. ..

¥ Use nearest pin as reference pin

™ Group pins within the reference distance

Circuit Element Type
¢ Capacitor " Port
Expand | Collapse | Find Pin at Location. .. | & Inductor € Current Source
" Resistor = Voltage Source

Reg Expression syntax {Net name}: {Pin name} ™ 5-param Cir Elem [ Voltage Probe

Reg exp: I LI " Terminal Delete | Edit |

QK |

Maming Convention

© 2015 ANSYS, Inc. January 31,2017 ANSYS Confidential




Create Simple VRM Output Model

[N Gircuit Element Generation Dialog i ] 5]

r— Positive Terminal Component Reference Terminal Companent
Part Name: [vRMOOL ] | | Parthame: [vmmnot =

* Enter in the Name text box Refoss: [ =1 | | refoes [ o

|7 Same as Positive Terminal

° Enter in the Pa rt N u m ber text box r Circuit Element Positive Terminal ————— [ Circuit Element Reference Terminal ———— |~ Circuit Elements
[=)- Pin Groups [=)- Pin Groups - Capacitors
. (= + 17y VRMOO1 VRM1 PIFlow | L.P=+1,2V_VRMOO1_VRM1_PIFlow - Current Sources
° E nte r In th e I n d u cta nce te xt bo X . +;;‘GND_\J‘RMDD 1_VRM1_PTFlow GND_VRMOO1 VRM1 PIFlow E| Ingd..uxfm e
43,3
. ey . [- GND [#-GND -~ Resistors
* Enter 0 in the Parasitic Capacitance text box pws
Voltage Probes
i Voltage Sources
H °a® H i Terminals
* Enter in the Parasitic Resistance text box
* Click OK to create the Inductor
x
Expand | Collapse | Find Fin at Location...
¥ Use nearest pin as reference pin
Marne: IL_"\"'HM1 " Group pins within the reference distance
Part Mumber; |VFEM1_SIMF'LE ~|
Inductance:  |0.471e-3 Nl Circuit Element Type
. (D _ ||:| " Capadtor " Port
arazitic Capacitance:
. s . Farads Expand | Collapse | Find Fin at Location. .. | ' Inductor ¢ Current Source
Parazitic Resistance: |Be-3 Ohms " Resistor " Voltage Source
P B T S A R TR " 5-Param Cir Elem 7~ Voltage Probe
ak. I Cancel Regexp: I LI " Terminal Delete | LI

e

Maming Convention Create QK I Cancel |
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Set Up S-parameter Sweep

x
Sweep | sensitiity | Distrbuted Analysis (HPC) |

GO to bUtton Simulation name:

| 5YZ Sweep 1 =]
. . . ¥ Compute exact DC point

Enter in the Simulation Name text box e

Start Freq Stop Freq  |[Mum. Paints [ Step Size IDistribution
Turn on the | ! |oHz OHz 1 Linear

i 1kHz 1GHz 200 By Decade

Set up the following frequency ranges using the Add Above/Add Below/Delete I I I

Add Above Add Below Delete Selection Preview. ..
Selection buttons:

~Sweep Selection .
I~ setFws generation parameters

IMin Rise/Fall Time /= |
¥ Interpolating Sweep

™ sIwave with 30 DDM
Relative error for 5: I 0,001

Select the Interpolating sweep option button and enter in the Relative Error e ster optiors.. |
for S text box

” Discrete Sweep

Turn off the Export Touchstone File After Simulation Completes check box

- Export Touchstone @ file after simulation completes

1_Advisor_example.s3p Browse. .. |

File path: |-:: training P

Click button

Save Settings | Launch I Close L
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x
P I O ° S Slﬂ’ll SIJPI Advanced | DC | DC Advanced | Multiprocessing | Met Prooessingl
ptlons etu p £ st smuation
i
Optimum speed Balanced O SEEURETY.
& P simulation
1
il |
. - - Optimum speed Balanced Optimum accuracy
* Onthe select the Pl Simulation option button
a n d set th e s I id e r to Ba Ia n ced - Cusba (zelecting this option allows you to configure advanced solver settings) _I
x
° On the tu rn Off the Custom check box a nd set SIfFI | SI/PI Advanced DCl DC Advanced | Multiprocessing | NetProoessingI
the slider to Balanced |
Optimum speed Balanced Optimum accuracy
* Onthe set the Number of Cores to
the n u m ber Of phySica I processor cores in you r : Custom (selecting this option allows you to configure advanced solver settings)
. v Flot Current Density and Voltage Distribution
machine, turn on the check box, and e CEEEEEER
select the option button for the type of HPC licenses x|
‘sifp1 | sipIAdvanced | D€ | DC Advanced {f
you have IIFPI'“'IuHJ'|:ir(lI:P(:essti:|r'|g : d d
Mumber of cores to use: ;I 4
. . =l
* Click to save any changes and close the dialog o et rperon
i+ HPC Pack
Max. 30 % of total
Simulation server name: I localhost Port: I 31000
,TI Cancel A
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Launch S-parameter Sweep

* Click to start the SYZ parameter analysis

Process Maonitor (SYZ Sweep 1)

Display: |Messages v @ 0

Performing basic DRC...
Identifying non-functional pads...
Identifying geometry Lo process...
Processing planes...

=l

- 0 X

Setup: |

253 |

Simulation: [

B Messages Process Monitor [SYZ Sweep 1)

© 2015ANSYS, Inc.

January 31,2017

Compute SYZ-parameters

Sweep | Sensitivity | Distributed Analysis (HPC) |

Simulation name: I SYZ Sweep 1| j

v Compute exact DC point

— Frequency Range Setup

Start Freq Stop Freq [Mum. Points [ Step Size IDistribution
1 |0Hz OHz 1 Linear
2 |1kHz 1GHz 200 By Decade
Add sbove | | AddEelow | Delete Selection | Preview. .. |

~Sweep Selection )
™ setFws generation parameters

IMin Rise/Fall Time /s |
¥ Interpolating Sweep

™ slwave with 30 DDM
Relative error for 5: I 0.001

Other solver options... |

" Discrete Sweep

I Export Touchstone® file after simulation completes

File path: |C:'-_training'-PI_.-‘Ad'.'isc-l'_example.s?p Erowise. .. |

Save Settings | Launch I Cloze

|

4
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Plot PDN Impedance (Board + VRM)

* On the Results ribbon click to raise the SYZ Parameter Plot dialog

* Activate the Z-Parameter Plot tab to display the impedance seen by the CPU1 device with all capacitors

deactivated and the simple VRM model

* Click the Plot In Electronics Desktop button to launch ANSYS Electronics Desktop and plot the impedance in that
interface as well

SYZ Sweep 1 Z Plot 1 PI_Advisor_example #
Z-parameter Plot * 100.00 Curve nfo
=Rl E N — Mag(Z(+1.2V_BGA_CPU_CPU1_PIFlow,+1.2V_BGA_CPU_CPU1_PIFlow) )
SYZ Sweep 1: SYZ Sweep 1
- Matrix Entries to Plot Z-parameters
Plat Row Col
v +1.2V_BGA_CPU_CP... +1.2V_BGA_CPU_CP..
10.00 A
1.00 4
(]
o
1E0 2
=
[=)]
] ©
E =
g 0.10 4
¥ Select self terms [ Select transmission terms 0.01
Regular expression syntax: {PORT1}:{PORTZ} Stél_ECtI .
Reqular expression: |— Unselect
r Export for Post-Processing
Plot Neme: [ZPlot 1
. 0.00 T T T T T
Export to ndExplorer 1E-3 152 1E-1 1E0 1EL 1E2 163 0.00 0.00 0.00 0.00 0.01 0.10 1.00
Frequency [MHz] F [GHz]
S-parameter Plot  Y-parameter Plat  Z-parameter Plot
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Set Up and Run Resonant Mode Simulation

* Goto x|

* Enter in the Simulation Name text box I & -
3

* Enter in the Minimum Frequency text box

Simulation name;

* Enter in the Maximum Frequency text box | Resonant Mode Sim 1 [

— Find Modes in Frequency Range

Minimum Freguency: I 1.5E+08 Hz

Restore Recommended Minimum Frequency |

* Enter 30 in the # of Modes to Compute text box

* Click to start the Resonant Mode simulation

Maximum Fregquency: 1E+09 Hz

# of Modes to I 30

Qther solver options. .. |

Save Settings | Launch I Close |
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Examine Resonant Mode Simulation Results

e Results = Resonant Mode > Resonant Mode Sim 1 > View Results
to open the results dialog

— Note that the second found mode at 211 MHz appears to correlate with the
first large spike in the impedance plot from the earlier SYZ simulation

— To view the shape of the modes select VCC and GND in the Plot Voltage
Difference pull down menus and click the Compute button

* After viewing the plots click Close

fi\ Resonant Modes{Resonant Mode Sim 1) I ] [ SYZ Sweep 1 Z Plot 1 PI_Advisor_example #
Vode | Re.Freq GHz)_ | im. Frea )& [ Wavelengih § 3 - oo e 2y Beh ézurcpm_?;;rouw,ﬂ.2V_BGA_CPU_CPU1_PIFIOW) )
1 R =Wk 1S ul w—]-wﬁ-l
|2 0.210877334 0.002825127 4.41566211 1421643816 37.325093400) qrm— >
T T 75652557 TOTE50TS52 SI7IETE TTES5TE0T TS 10004
4 0.337557303 0.005383112 708307388 0.887070418 28 247078400
5 0.355836441 0.007092766 7.45778033 0.842500722 25.08594423400
[ 0.383567318 0.007670746 8.03897654 0.781590203 25.006955000 1.004
7 0.41821402% 0.002884086 876511791 0.716835733 72.505461800 o
o N ETHMAI0RT N ANGRI0100 10 GCANRT0C N ETIIONRCC T A1ATIA bl §
| ni‘ _’l_l g
=
Plot voltage difference b planes on 0.10
P"m o o ] Come |
001

Wode [ Flot Layer [ Reference Layer | N
1 VCC GND
3 vee GND %% 00 000 0.00 0.00 001 0.0 .00
4 VCC GND = F[GHz]
5 VCe GND
[ Ve GND
7 vcC GND
8 VCe GND
9 vCC GND
10 VCe GND LI

Phase Animation... |




Realize Your Product Promise®

Impedance Analysis

Z11 extraction and Resonant mode analysis with active capacitors




Activate All Capacitors

* On the Home ribbon click the button

— On the Capacitors tab select all the capacitors by clicking the first row in the list, scrolling to the bottom of the list, holding down
Shift on the keyboard, and clicking the last row in the list

— Click the buttonto reactivate all the capacitors
x|
Capacitors I Inductors I Resistors I Ports | Voltage Probes I Cument Sources | Voltage Sources | MNet Teminals I
& | Active | 8.-"3f| Part Number | RefDes | Capacitance (F) | Parasitic L (H) | Parasitic R {ohms) | Positive "Tennin;:l
¥ Yes b 4 GRM1885CTHE20MAN  C1 2.2E-11 5.7604E-10 0.209768 +1.2V —
W Yes 4 GRM188B11E473KADT  C2 47E08 5.08675E-10 00318335 +1.2V
W Yes 4 GRM1882C1H121JA00 C3 1.2E-10 6.0512E10 0164012 +1.2V
W Yes b 4 GRM1885C2A221JA01 C4 22E10 £.33676E-10  0.113806 +1.2v
o Yes b 4 GRM185RE0J225KE2E  C5 22E06 3.02696E-10  0.0100616 +1.2v
W Yes b4 GRM188B11CT104KADT  CE 1E07 507437610 0.0221146 +1.2V
W Yes 4 GRM1882C1E1020A00  C7 1E09 470102E10 0.0638092 +1.2V
W Yes 4 GRM188B11C104KADT CB 1E07 BO07437E-10  0.0231146 +1.2v
W Yes b 4 GRM188B11C104KADT C3 1E07 B07437E-10 00231146 +1.2v
W Yes 4 GRM1882C1ES61JA01 CNM B6E-10 4773T4E10 0.0647184 +1.2V =
- | of

139 capacitors, 139 active, 0 inactive

[ mdify Properties...l I odify Layers.... Delete | Fit Selection Achivate | [eactivate |

Bpot ok | CancelJ’
AL
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Set Up S-parameter Simulation

x|
* On the SImU|atI0n I"Ibbon CI'Ck the button Sweep | Sensitivity | Distributed Analysis (HPC) |
— Enter in the Simulation Name text box Smiatonnanes 51z sneep =
7 Compute exact DC point
- Turn On the — Frequency Range Setup
— Set up the following frequency ranges using the Add Above/Add Below/Delete Selection | e
1 |OHz OHz 1 Linear
buttO nS: Z 1kHz 1GHz 200 By Decade
&dd Aboye &dd Belowy | Delete Selection | Preview... |

— Select the Interpolating sweep option button and enter 0.001 in the Relative Error for S text box CSweepSelection o parameters

" Discrete Sweep

— Turn off the Export Touchstone File After Simulation Completes check box “l_

' Interpolating Sweep

* Click to start the S-parameter simulation e | | EEEe SR
Other solver options... |

[~ Export Touchstone® file after simulation completes

File path: | C:\training\PI_Advisor_example.s3p Brovse,.. |

Save Seﬂingsl Launch I Cloze i
|
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Plot PDN Impedance (Board + Capacitors + VRM)

* On the Results ribbon click to raise the SYZ Parameter Plot dialog

* Activate the Z-Parameter Plot tab to display the impedance seen by the CPU1 device with all capacitors
activated and the simple VRM model

* Click the Plot In Electronics Desktop button to launch ANSYS Electronics Desktop and plot the impedance in that
interface as well

7 parameter Plot SYZ Sweep 2 Z Plot 1 PI_Advisor_example #
O B 1.00 Curvelnfo
— Mag(Z(+1.2V_BGA_CPU_CPU1_PIFlow,+1.2V_BGA_CPU_CPU1_PIFlow) )
Matix Entries to Plot Z-parameters SYZ Sweep 2 : SYZ Sweep 2
Flo | Fow Col =
vl +12V_BGA_CPU_CP.. +12V_BGA_CPU_CP.
0.10
o
o kel
3 2
2 E
z g
=
0.01
[ Selectselfterms [~ Select transmission terms
Regular expression syntax: {PORT 1}: {PORTZ} _ sekect|
Reguarexpression: [ Unselect
[ Export for PostProcessing ——————————————
PlotIn Bectonics Desktop | Plothame: [Zplott
Export to ndExplorer ® fE-] 162 1E-1 1E0
Fraquency [MHz]
0.00 T T T T T
0.00 0.00 0.00 0.00 0.01 0.10 1.00
F [GHz]
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Set Up and Run Resonant Mode Simulation

* Goto x|

* Enter in the Simulation Name text box I & -
3

* Enter in the Minimum Frequency text box

Simulation name;

* Enter in the Maximum Frequency text box | Resonant Mode Sim 1 [

— Find Modes in Frequency Range

Minimum Freguency: I 1.5E+08 Hz

Restore Recommended Minimum Frequency |

* Enter 30 in the # of Modes to Compute text box

* Click to start the Resonant Mode simulation

Maximum Fregquency: 1E+09 Hz

# of Modes to I 30

Qther solver options. .. |

Save Settings | Launch I Close |
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Examine Resonant Mode Simulation Results

e Results = Resonant Mode > Resonant Mode Sim 1 > View Results
to open the results dialog

— Note that the 12th found mode at 351 MHz appears to correlate with a spike in
the impedance plot from the earlier SYZ simulation

— To view the shape of the modes select VCC and GND in the Plot Voltage
Difference pull down menus and click the Compute button

* After viewing the plots click Close

fi\ Resonant Modes(Resonant Mode Sim 2) =10 x|
Mode | Re. Freq (GHz)__|Im. Frea (GHz)__| & [ Wavekngih m)_ |G | 100 SYZ Sweep 2 Z Plot 1 - PI_Advisor_example 4
7 0.271475137 0.001482907 568963815 1.104308075 91.536156500 — Mag(Z(+1.2V_BGA_CPU_CPU1_PIFlow,+1.2V_BGA_CPU_CPU1_PIFlow) )
8 0.283130885 0014230171 593524207 1.058623260 9.962922300 SYZ Swieep 2: SVZ Stieep 2. - —
9 0.283448765 0.038784346 5.34064624 1.057660130 3688213500
10 0.288140258 0.008030368 £.03897326 17.945289100
12 0.351237237 0.014198117 7.36138814 12.379250200
T3 0370870100 TOT28T5875 777286253 12.5mr—vf 0.10
f nmacaice nn1RoANAE = onanenes 11 7704673
y T
]
Plot voltage planes on %
’7|vcn =] and JenD =] Compue | g
0.01
Made | Plot Layer | Reference Layer | ]
7 vee GND
2 vee GND
9 vee GND
10 vee GND
1 vee GND
2 VEC 0.00 T T T T
13 VCC GND 0.00 0.00 0.00 F"[Egl‘-)lz] 0.01 0.10 1.00
14 vee GND
15 vee GND
16 vee GND [
Pram .|

WKW =

IS




Realize Your Product Promise®

Impedance Target Definition

(OPTIONAL)




40

Ipositive(load) [mA]

Please refer to Workshop Slwave LnlL WSP03 Optional.pptx located in the same directory as this workshop to
follow a simple exercise for defining target impedance
Non-DC Load Current Targetz . 1000.00 Target Impedance Target Z Experiments 4
375.00 = @ﬁ:‘;ﬁiﬁfsﬂ‘”?w 312.5000 —egmre;:gr(ezz(";;:ﬂ Port1)) Llr;nL,n;;
250.00 1 I . H w
125.00 ‘ | :: I [ _
| H I Al —_—
.o I LAE il | I — £
MY \ l I
- AN | | {1 A :
A | | 5
-250.00 | : ]] ]‘ I [ ‘ ‘ £ '
il __ | =
-375.00 | | T T T V'
D.‘ 0 2.00 4.00 Tin?é)g:s] 8.00 10.00 12;DD {=_16.00}
o o 100050 0.00 0.00 0.00 0.01 0.10 1.00
- F [GHz] ot
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Realize Your Product Promise®

Pl Advisor Simulation

Capacitor Optimization




Deactivate Simple VRM Model

* In Slwave on the Home ribbon click the Circuit Element Parameters button

— Activate the tab
— Click the inductor instance L_VRML1 to select it
— Click the button to deactivate the simple VRM model
— Activate the tab
— Click the port to select it
— Click the buttonto reactivate the port at the VRM output
x x
.Capacitors Inductors | Resistors I Ports I Voltage Probes I Current Sources I Voltage Sources I Net Terminals I .Capacitors I Inductors I Resistors Forts |‘u"o|tage Probes I Current Sources I Voltage Sources I Net Terminals I
# | Active | 8.-“3{ | Part Number I H_;ejDes I Inductance (H) I Parasitic C!E! | Parasitic F{!ohms! | Positive "Terminal" Met # | Active I Mame | Reference Impedance (Ohms) | Port Positive "Terminal" Net | Port Negative "Terminal”
¥ No 4 WVEM1_SIMPLE L_WRM1 4T71E-10 0 0.008 +1.2V W Yes +1.2V_BGA_CPU_CPU1_PIFlow 0.1 +1.2V GND
W MNo b 4 LQG15WHINOBDZ L5 1E-09 0 00192417 +3.3V Wi Yes +1.2%_VEMOO01_VEM1_PIFlew 0.1 +1.2V GND
W No b4 LQG15WHINOEDZ L6 1E-09 0 0.0192417 +3.3V
¥  MNo 4 LQG1SWHINDOBDZ L23 1E-09 i] 0.0152417 +3.3V
W MNo 4 LQG15WHINOBDZ L38 1E-09 i] 0.0152417 +3.3V
W MNo b 4 LQG15WHINOBDZ L33 1E-09 0 0.0192417 2.5V_LAN
¥ No b 4 LQG15WHINOBDZ L75 1E-09 0 00192417 +BY_POWER
¥ No b4 LQG15WHINOBDZ L76 1E-09 0 0.0192417 PVCCH
¥ MNo b 4 LOG1SWHINDOBDZ L77 1E-05 i] 0.0152417 PVCC2
W No b 4 LQG15WHINOBDZ L78 1E-09 0 0.0192417 AVCC
4| | | | | i3
10 inductors, 0 active, 10inactive 2 ports, 2 active, Dinactive
[ mdify F‘roperties...l [ odify Layers. .. Delete Fit S election | Achvate | [Meachvate | [ mdify F‘roperties...l [ odify Layers. .. Delete Fit S election | Achvate | [Meachvate |

oo ok | t:anceJJJ oo ok | t:anceJJJ
T T
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Pl Advisor Workflow Diagram

Pl Advisor -
Step 1
Setup 5

© 2015ANSYS, Inc.

Capacitors for
Optimization

Capacitor
Candidate Selection
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Define Target Impedance and VRM Parameters

EN PI Advisor Wizard Step 1 x|

Check ports where impedance

e Goto to raise the Pl Advisor Step 1 dialog e e e
— In the list of ports on the left click the Enforce |Z| check box for the = E—

b |+1.2V_BGA_... v
+1.2V_VRMOD...

Impedance magnitude at port +1.2V_BGA_CPU_CPU1_PIFlow

— Click the port to select it

— In the VRM Parameters area set the following options:
¢ Location:

1Z11| [ohm]

e ESL: 1E1
¢ ESR:
* In the Required |Z11| area you can right click and select e e S S i S Skl
to add a target impedance between a minimum and maximum L :q“:[lm‘l
frequency, but in this case we have provided a loadable target due Location: [+1.20 VRNODLVRWLPIFon 7] | | Reht-dekin table o o o defte rons
to the large number of steps e [a70e  # Eifaonoe0s  oms TR :I
— Click the button, browse to the file —g;mjm mdem::?— 123 ig? Egif
and select it, and click Open to load the target impedance profile ¥ itV st impedncein [BIS] 21 398 0031 i
[ Plot total |Z11] at portin [ =] "] save [z] Profile... |

— After reviewing the settings click the Next button to advance to Step 2
Mext al Cancel ﬁl

)|

ANSYS Confidential

© 2015ANSYS, Inc. January 31,2017



Select Capacitors To Optimize

* In this step we will select the capacitor locations we want to optimize; the list
will display all the capacitors that are visible to the ports selected for enforcing

the impedance magnitude, but not all these capacitors are directly connected
e Part Name Ref. Des. | Value (F) Optimize 1=
— To sort the list by reference designator, click the Ref Des column header GRAM1885C THEZ0JADT i B2E-M1 g
GRM188B11E473KAN c2 4. 7E08 ~
GRM1882CTHI21JADN c3 1.2E-10 ~
* Select the following capacitor reference designators: i L] e il .
GRM188B11C104KAN Ce& 1ED07 ~
GRM1882C1E102JA01 Cc7 1ED05 ~
GRM188B11C104KAN [0e:3 1ED07 ~
GRM188B11C104KAN [ee:] 1ED07 ~
GRM1882C1ES61JADT C11 5.6E-10 bl
GRM188B11C104KADN ciz 1ED07 bl
GRM1882CTH101JAD C13 1E-10 bl b
GRM1881X1H122JA01 C14 1.2E-09 bl
GRM1882CTHEBOJAD Ci5 6.8E-11 bl
GRM188B11E223KAN Ci6 2208 bl
GRM1882C1E102JA01 ci7 1E-05 bl
GRM1882CTHE60JAN ci8 5.6E-11 bl
GRM185TX1HZ72)A44 C15 2.7E09 bl
GRM1882CTH101JAD C20 1E-10 bl
GRM188B11E473KAN C21 4.7E-08 bl
GRM31ABCZHZT1JWM Cc22 2.7E-10 bl
GRM188B11C104KAN C25 1ED07
GRM188B11C104KAN C30 1ED07
GRM188B11C104KAN C31 1ED07
GRM188B11C104KAN Cc3z 1ED07
GRM188B11CT104KAN C33 1ED7
GRM188B11CT104KAN C34 1ED7
GRM188B11CT104KAN C35 1ED7
GRM188B11CT104KAN c37 1ED7
* Confirm that there are selected for optimization before clicking SR I638 104K cue £
the Next button to advance to the next step Sl S = -
36 capacitors selected for optimization [ Previous | Net [ | Cancel 3 |
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Select Candidate Capacitors

Select candidate capacitor models for each reference designator to
be optimized x

. [ Capacitors Selected for Optimizaton —————— | Impedance
— In the area click the [z [erosTwa]
V GRM1882C1H121JA01 c43 1z
H o GRMI8B2CIHI01JAD1 ci3 1E
column header to sort the list by part name M
& GRM1882C1H101JAD1 C167 1E.
. . . . V GRM1882CIES61JAD1 ci1 5. i
— Select all the parts with part names beginning with ¢ emmcEso oo s
@ GRM1882C1E102JA01 c7 1E. =
+ GRMIi8B2CIE102]A01 c17 1iE 5
' GRM13B1X1H1221AD1 ci4 11 ==
In the Filters area: v o @ ||
@ GRM188B11E473KA01 c21 4.7
* o GRM188B11E473KADL c2 4.; 1E1
V GRM1388B11E223KA01 Ci16 22
. . .
— Click the Show header in the list to turn off all Vendors Mo
o GRMi88B11C104KADL Ci181 1iE
. . V GRM138B11C104KA01 C45 1E-
— Click the Show check box for to show only parts from this vendor V ewsmicoae o £ L |
o GRM188B11C104KA01 3 1E Frequency [MHe]
o GRM1i88B11A224KA01 Cc51 2. o
- CIiCk the Show header in the Iist to turn Off a" series g Eﬂﬁi;ﬁ;ﬁ;ﬁl Egg ; Vendor e Part Name Plt | Candidate | Vaiue... = EIASze | Price | Lmnt(H) | Rmnt fohms) | SRF (Hz) |
& ovpaanaan ool > Vurstz GAMT8 GRM183RETCTOSKAAL ald_[1E0S  0s3 0 E0 000 BTN -
R . . B ovissemwn oo b Muscta GRM13 GRM 183REIG22EMEAD Add_|22E05 0603 001 IE0S 0001 1599606 -
— Click the Show check box for to show only parts from this series D S cp o EEa SRRz M jaEs W oom Ew pm s
B Gemmcamwe. o > Vursta GRM13 GRM183CE0I226MEAD Add_|22E05 0603 001  E09 0001 15986406
B oo oz 2] Vursta GRM1B GRM 183830G226MEAD Add_|22605 0603 001  E0D 0001 1590506 -
H H H N Murats GRM18 GRM188B30U226MEAD Add [22605 0603 0o 1ED 0.001 1598E+06 -
— Click the Filter check box for the to turnit on and "y o M crue e e w i m weer Jj
1] | 3
I " h o d I . d . [ TR Assign Selected Candcat=(s) | [erice =T Update
Select all the CapaC|t0r moaeis In design i
Filters
Vendor | Series [ Part Name -
. e e Vendor  Show | &) | Serms Show | =] | EASes | Shaw |2 Fiter | Quarty Min Ma
-_— Cllck the Murata GRM18 GRM185831A105KE35 AWK GRM15 g Value (F) SE-14 00033
o Johanson pkad = ols | v | SRFRange ()  1E=06 TE09
Murata GRM1S GRMI185B31C1DSMES3 Kemet GRM21 g;gl * 4 :E';‘"HHE"EE ‘:B)) j:?;gus :592;;;7
1 1 1 H Murata GRM13 GRMIB5BIIE105KAL2 b Murta = = ange (ohms) 4.99782E
— Repeat this process to assign all capacitor models matching the same set of I e ) o EsL a0 0
. . Murata GRM18 GRM185CE0I105KE26 23”“””9 GRMA2 B gggi % Frice g oo
. =
for the capacitors with part names e s cvnmse o R | CEEEl

beginning with GRM31 e | | et | (G | ot | et &

Click Next to advance to the next step
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Select Candidate Capacitors for 1206-size Locations

x
[ Capacitors Selected for Optimizaton ————————————————— Impedance
| Part Name | Ref. Des. | \daI;l 5
& GRM1832C1H1711A01 c43 13
o GRM1BA2CIHID11AD1 c13 1E-
' GRMIB32CIHID1IADL cn i B2
& GRM1B32C1H1D11A01 c157 1E-
 GRMIBA2CIES611A01 o1 5.6
' GRMIB32C1ES611A01 ci70 5.6 1B
 GRM1832C1E1027401 c7 IE- -
o GRMIBE2CIE1027401 c17 1E £
¥ GRM1831X1H122JA01 cia 12 — '
& GRMIBSIXIHITZIA44 c19 23 g
o GRMIBEE1IE473KAD1 c21 4.3
& GRM1BSB11E473KANL c2 43 E1
 GRM1B3B11E223AN1 cis 23
& GRM188B11C104KA01 e 1E
& GRM1BSB11C104KAD1 ca 1E- 152
o GRMIBER1IC104KAD1 c181 1E-
¥ GRM1BSB11C104KAD1 45 1
& GRM1BSB11C104KAD1 c12 1E- 3
V GRM188511C104<A01 ca 1E- 1E-4 1E-3 1E-2 1E-1 1E0 1E1 1E2 1E3 1E4
¥ GRMIBSB11AZ24KAD1 51 23 Freauency [Hri]
¥ GRMISSE11A22KA0L e 23 Vendar Series Part Name Plot | Candidate | Value.. ~ EIASize |Price  Lmnt(H) | R_mt(chms) | SAF (Hz) |
ﬁ o z Murata GRM31 GRM31CC80E157ME11 Add 0.00015 1206 0 1E-10 0.001 358074 4
o Murats GRM31 GRM31CREM15TMETT Add | 000015 1206 1] 1E-10 0.001 398074 |
M Murata GRM31 GRM31CRE0G227MET1 Add 0.00022 1206 1] 1E-10 0.001 320625 E
v Murata GRM31 GRM31CCB0G227ME11 Add 0.00022 1206 0 1E-10 0.001 333077 4
W Murats GRM31 GRM31CCBOEZZTMEN Add | 000022 1206 (1] 1E-10 0001 333077 |
- Murata GRM31 GRM31CRE0E227ME11 Add 0.00022 1206 1] 1E-10 0.001 320625
4| | _»l_ Murata GRM31 GRM31CRE60J227MET1 Add 0.00022 1206 0 1E-10 0.001 333077
4] |
- Assigned Candidate Models ————————————————— Assign Selected Candidate(s) | IPnce j I Update |
520 candidates, 0 selected
[ Filters
Vendor | Series I Part Name: :I
Murata GRM31 GRM31ASCIHIO IJWDI_I Vendor Show | & Series Show ;I ElASize | Show = Fitter | Quantity Min Max.
Murata GRM31 GRM31A5C2H1210W01 AVX GRS = Value (F) 5E-14 0.0033
Murata GaMa1 CGRM31ASC2H1511W01 .}J:Bhanson GRM18 01005 ] F v SRF.Range (Hz) 1000 1E+09 _
Murata cRM3L GRM31ASC2H13 WO L met RN 020 ™ S_in Range (d8) -1 Dsj‘m 6.02147
Murats ML CRMILASC2H221 W01 bt [T s = 0204 v ESR Fange (ohms) 499768505 499982
Murata GRM31 GRM31ASC2HR71IW01 Panasonic GRM32 _I 0306 ] ESL Range {H} 1] 0.00518712
Murata GRM31 GRM31ASC2HIILIWDL Samsung GRMA2 0402 L Price 0 0.0
Murata GRM31 GRM31ASC2HIN0MO1 w Saryo GRM&3 0508 1
1 | _,l_l Syfer =l ~RMER | 0603 | Load Filters... I Save Filters... |
Remove | Flot [Z11]]
@ Previous | Next ﬂ | Cancel x |
A|
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Set Up Pl Advisor Simulation

* Enter in the Name text box

* Enter in the Number of Generations text box

* Click the Edit button in the S-parameter Sweep Configuration row
— Configure as shown and select OK

* Click Launch Optimizer to launch the simulation

48

[x] [N P1 Advisor Wizard Step 4 x|
x
Sweep I _ ~
4 Simulation 4 SiEh
Name Pl Opt Sim 1 ¥ Compute exact DC point Name Pl Opt Sim 1
S-parameter Source [ Recompute | - S-parameter Source [ Recompute ]
Sparameter Solver Slwave Frequency Range Setup S-parameter Solver Slwave
4 Atributes to Minimize StartFreq | Stop Freg |Num. Fonts / Step Size | Distrbuton 4 Attributes to Minimize
| Total price | Total price
| Total number of capacitors By Decace +| Total number of capacitors
| Total number of capacitor types | Total number of capacitor types
| Total capacitor area | Total capacior area
4 Atribute Weights = B
4 Attribute Weights
Price weight o Add Above Add Below I Delete Selection | Preview... | Pri aht - 0
rice Wei
MNumber of capacitors weight 1 g . .
§ . Number of capacitars weight 1
Number of capacitor types weight ] Erer R
Capacitor area weight 0 & Restore Default Sweep | Number of capacitor types weight 0
£ i i ?
4 Optimizer Control Parameters Discrete Sneep — Capacitor area weight 0
Members per generation 100 Min Rise/Fall Tme /s 4 Optimizer Control Parameters
Number of generations 100 SE-10 Members per generation 100
Number of schemes to report 10 & Interpolating Sweep Number of generations 100
4 Thresholds Relative error for 5: ID.D[|1 I™ Stnave nith 30 DM Number of schemes to report 10
Maximum total price (S) 5.00 4 Threshold
Madmum number of capacitors 100 MI o
Maximum total price (5) 500
Maximum number of capacitor types 20 Maximum number of capacitors 100
Maximum total capacitor area {mils “2) 3534346 212 Vi ber of P B 2
4 S-parameter Simulation Options axfmum numoer C.:aDaCI‘tDr.TVPEf
Impedance Mask Range 100000Hz -> 1E+09Hz Maximum total ca_pacrlur_area I_rrul_s 2 3534346212
Sweep Range DHz > 1E+D9Hz, 1202 poirts 4 S-parameter Simulation Options
S-parameter Sweep Configuration Edt Impedance Mask Range 100000Hz = 1E+09Hz
Sweep Range 0Hz -» 1E+05Hz. 1202 points
S-parameter Sweep Configuration Edit |
(& Previous | ! Launch Optimizer
Close (& Previous "Launch Optimizer ] Cancel g |
¥ £
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Pl Advisor Result

Go to and save the project as

On the Results ribbon click
to examine the Pl Advisor results
— Click to select it
check box

— Note that this scheme has just in the original design,

indicating that the PCB was overdesigned for the PDN requirements

— Click the button to assign the capacitors for this
scheme to the design

» Capacitors marked (empty) will be deactivated
» Capacitors marked with a part name will have that candidate model applied

Click to close the dialog

© 2015ANSYS, Inc. January 31,2017

[N P10pt Sim 1 Optimization Results x|
[~ Schemes - -
Impedance at port "+1.2V_BGA_CPU_CPU1_PIFlow" for Scheme 8

Name I Quality Metric | Price () | MNum Caps = =
Scheme 8 i 0.09 i
Scheme 7 0,939888 0.26 3|
Scheme & 0.939781 0.21 30
Scheme 5 0,999537 0.15 15
Scheme 4 0.999523 0.13 23
Scheme 3 0,999438 012 16 frae
Scheme 2 0,999431 0.22 28
Scheme 1 1.999391 0.13 15 _'ﬂ
4 | »

Apply Scheme to Design | Expaort Scheme BOM. .. |

1E-1
[~ Capaditors Selected for Scheme 8
Capacitor I Value (F) I Vendor | Series | Pari +
c1 (empty) T
c2 5.6E-09 Murata GRM18 GRM i
Cc3 3.3E-08 Murata GRM18 GRM E
c4 1.5E-07 Murata GRM18 GRM -
cs (empty)
ce 1E-06 Murata GRM18 GRM
c7 (empty)
cs8 (empty) 152
cs (empty)
cn (empty) |
c1z2 (empty)
Cc13 1E-05 Murata GRM18 GRM
c14 (empty)
c15 (empty)
Ci6 (empty)
c17 (empty)
c18 (empty)
c19 (empty)
c2o (empty)
c21 (empty) _lﬂ 1e3
4 3 1E-3 1E-2 1E-1 1E0 1E1 1E2 1E3
Frequency [MHz]
Fit. Selection
Port: |+1‘2\I_BGA_CPU_CPU1_P ~| ¥ Show impedance mask: Export Touchstone file... I Close I

=
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Confirm Scheme Applied To Design

* On the Home ribbon click the Circuit Element Parameters button

* In the capacitors list confirm that there are now 25 inactive capacitors; these are the capacitors that were
marked (empty) in the Pl Advisor scheme applied to the design

e Click OK to close the dialog

x
Capacitors I Inductors I Resistors I Ports | Voltage Probes I Current Sources | Voltage Sources | Net Temminals I
£ | Active | 3.-"3f| Part Number | RefDes | Capacitance (F) | Parasitic L (H) | Parasttic R {chms) I Positive "Temir A|
W Yes b 4 GRM1851X1AS62)A44  C2 5.6E-09 4.8342E-10 0.0415564 1.2V
W Yes b 4 GRM188RE1A335KETS C3 33E-06 3.65715E-10  0.0074917 1.2V
W Yes b4 GRM188R71A154KADT  C4 1507 542439610 00174132 1.2V
W Yes b4 GRM188RE1A105KAGT  CE 1E06 5.22851E10  0.00866103 1.2V
W Yes 4 GRM188RE1E1D6MATI C13 1E05 401327E-10 0.00488105 1.2V
W Yes b 4 GRM188B11C104KADT  C23 1E07 5.07437E-10  0.0231146 GND
W Yes b 4 GRM188B11C104KADT C24 1E07 5.07437E-10  0.0231146 GND
W Yes b 4 GRM188B11C104KADT  C25 1E07 5.07437E-10  0.0231146 GND
o Yes b 4 GRM188B11C104KADT  C26 1E07 5.07437E-10  0.0231146 GND
W Yes b4 GRM188B11C104KADT €27 1EQ7 5.07437E-10  0.0231146 PLLVCC =
« _ | ;I_I
139 capacitors, 114 active, 25 inactive
o medifyy F‘roperties...l F mdify Lavers... Delete | Eit Selection Achivate | [eactivate |

Export ok | t:anceJJJ
T
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Set Up S-parameter Simulation

5
Sweep | sensitiity | Distrbuted Analysis (HPC) |
Simulation name: |5Y2 Sweep 3 j
* On the Simulation ribbon click the button [P E—
— Frequency Range Setup
— Enter in the Simulation Name text box StartFreq | StopFreq |Num. Points / Step Size | Distrbution
1 |0Hz OHz 1 Linear
— Turn on the Z 1kHz 1GHz 200 By Decade
— Set up the following frequency ranges using the Add Above/Add Below/Delete Selection
buttons. Ldd sbeve | addBelow | Delete Selection | Preview. .. |
~Sweep Selection .
~ Distrete S I~ setFws generation parameters
IMin Rise/Fall Time /= |
— Select the Interpolating sweep option button and enter 0.001 in the Relative Error for S text box & Interpolating Swesp
) ; [™ siwave with 30 DDM
— Turn off the Export Touchstone File After Simulation Completes check box S B |
* Click to start the S-parameter simulation
- Export Touchstone @ file after simulation completes
File path: I-C: iraining\PI_Advisor_example.s3p Browise, ., |
Save Gettings | Launch Close L
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Export State-Space Model for Circuit Simulation

* Onthe
— Turn on the Change Output File Format check box and select the option button
— Turnon the check box
— Click Browse to specify a file name and location; save the model in the same directory as your Slwave projects

* Click OK to generate and export the model
x|

—Macromodel Qutput Options

Output File: IC:J"traininngYZ_S'J\'eepj_sp_Z.sss Browse I
[V Change output file format
" HSPICE " Touchstone 1.0 " Touchstone 2.0

" PSPICE

~ Spectre

% Nexxim State Space

" Simplorer

™ HSPICE-Foster (pole-residue)

V¥ Use common ground

—Macromodel Generator Options

[¥ Enforce model passivity Desired fitting error: |0.5— %
W Ensure accurate Z-fit [ Renormalize I 50 ahims

—Miscellaneous Options

r CO"”IJEVEﬁt Edit descriptian |

Advanced >>|
QK I Cancel
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Opening ANSYS Electronics Desktop

Starting ANSYS Electronics Desktop

— To launch Slwave, click the Microsoft Start Button > ALL Programs > ANSYS Electromagnetics > ANSYS Electromagnetics Suite 18.0
— Select the ANSYS Electronics Desktop 2017.0 executable.

Open an Electronics Desktop Project

— Select the File > Open menu item
e Browse to the file: PI_advanced_circuit.aedt
e C(Click the Open button
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PDN Impedance Measurement Circuit

* Double click on the

to open the schematic

* We will add the State Space model just generated to this circuit to compute the full PDN impedance

© 2015ANSYS, Inc.
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PDN Impedance Measurement Setup

* Inthe window click the button to show just importable model types
— Click to activate the state space model importer
— Browse to and select the file and click Open to import the model
— Click in the schematic to place the componentin a way that it is not connected to any wires because it needs to be flipped before
connecting
R
P 1.2k0hm
15kOhm
® +1.2V_BGA_CPU_CARU1_PFlow 1 +1.2V_VRM001_VRM1_PFlow -1
" — [F—= —=
68pF
e B2 e 1132 e, o
l ¥ @ [ EV I <
in- |- out o
() R6 C133
W4
1.2kOhm 69UF
LL:U:JV [ l ’
_ 10
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PDN Impedance Measurement

* Right-click on the state-space model component and select to flip it
— Click and drag on the component to connectit to the existing wires between the VRM model and the load

* Expand , right click on the solution setup, and click Analyze to run
the impedance simulation

* Expand and double click on the report named to open the report

and examine the results

R7

RS 1.20hm
-— —
15k0hm
@
y— —
68pF
! = 1132 pos
in+ out+ +1.2V_VRVOO1_VRM1_PFlow -1 +1.2V_BCA| CPU_CPUI_PAow1 [ oad |yt
} G3 150H -
(o]
- |- out- o
RG C133
V4
1.2kOhm 68UF
-
| l | g
DCEOAV
_lo
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PDN Impedance (Board + Optimized Capacitors + VRM)

Full PDN Impedance Optimized PDN Z #
1000.00
— mag(Z(Port1,Port1)) T
LinearFrequency e
TR = 291571]

10000__ ITHITAAIN

mag(Z(Port1,Port1)) [mOhm]

10.00

=800}
1.00 T T T T T T T T T T i T T T T T T T T T T
0.00 0.00 0.00 0.00 0.01 0.10 1.00
F [GHz]
1.000000
0.000001
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Setup PDN Transient Circuit

* In the Project Manager double click on to open the schematic for the time domain
simulation of the PDN
— In the Component Libraries window click the to display just the componentsin the current project
— Click and drag out an instance of the model into the schematic

— As for the impedance circuit flip the model instance and connect it to the other models

R7

15kOhm

68pF
E2 L148 L U122
out+ +1.2V_VRMOO1_VRMI_PIFlow:1  +1.2V_BGA_GPU_CPU1_PIFlow:1 | oad

[ + G3 1.5nH
in- |- out-
R6 C149
V4
1.2kOhm

68uUF

! !

20A

SSA

DC=0.5V
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Run PDN Transient Circuit Simulation

* Expand
Analyze to run the simulation

* Expand
report and examine the results

, right click on the solution setup, and select

and double click on the report named

R7
R5 1.2k0hm
— —
15k0hm
c9
— —
68pF
i E2 L148 U122
in+ out+ +12V_VRMOO1_VRMI_PIFlow:1  +1.2Y_BGA_CPU_CPU1_PIFlow'1 | naq
I + G3 1.5nH <
a
in- out- ©
R6 C149
V4
1.2kOhm B8UF
<
| l J 4
DC=0.5V
L0
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Load Voltage Swing Within 50 mV Target!

Load Voltage Optimized PDN Transient 4

Curve Info pk2pk avg

1.02
1 — V(net_10)
NexximTransient 0.0447 0.9901

1.01+

1.00

V(net_10) [V]
o
©
[{s]

0.98
0.97
0.96 ' ' ' ' 1 ' ' ' ' 1 ' ' ' ' 1 ' ' ' ' i ' ' ' ' 1 ' ' ' '
0.00 2.00 4.00 6.00 8.00 10.00 12.00
Time [us]
[ ]
0.00 12.00
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